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Getting Started

First Steps

Download
Last updated: 2021-02-07T14:00:58.000Z | Online Version

There are two ways to download the software installer:

1. The 72-hour temporary link in the activation email received after your online purchase
2. In these articles, available after signing in

Forensic Studio
Forensic
Spotlight

Note: Legacy Installers can be found here

Install
Last updated: 2021-08-29T02:05:27.000Z | Online Version

After downloading the software, launch the .exe file and navigate through the installer prompts.

If you have installed versions of the software on the computer, please follow the prompt to uninstall previous versions prior to
updating. 
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Install LAV Filters
Last updated: 2021-01-28T17:18:40.000Z | Online Version

Download LAV Filters

In order to play video and audio, you need software which is able to translate the file into a format your computer can
understand.

LAV Filters are a set of open-source DirectShow filters that does this translation for all the popular video and audio formats: 

LAV Splitter: a source/splitter filter required to demux video files into their separate elementary streams.
LAV Audio and Video Decoder: powerful audio and video decoders with a focus on quality and performance.

You can find the latest version of the LAV Filters available here.

 

Activate
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Activate
Last updated: 2021-08-10T00:36:21.000Z | Online Version

There are two ways to activate your subscription:

1. In-App - The application will ask for a product key or V2C file upon launch when no valid license is available. 

2. Offline Activation - If you are activating a computer behind a restrictive firewall or with no network access you can use your
product key and the self-service portal available at https://activate.motiondsp.com

 

Basic Functionality

Keyboard Shortcuts
Last updated: 2021-06-17T15:16:34.000Z | Online Version

There are keyboard shortcuts that allow you to navigate the software settings without using your mouse. Located under the
HELP tab, select Keyboard Shortcuts. Use the side bar to scroll down for more shortcuts. 

Click on links below for full PDF 9.0 versions 

 

Forensic Studio-Forensic Keyboard Shortcuts

 

Spotlight Keyboard Shortcuts  
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How do I generate a Diagnostic Report?
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How do I generate a Diagnostic Report?
Last updated: 2021-01-28T17:19:37.000Z | Online Version

Crash reports should be generated automatically  on newer versions but if needed, here are the instructions: 

Navigate to Help, click on Diagnostics, and click Create Report 

 

Automatic Software Updates
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Automatic Software Updates
Last updated: 2021-01-28T17:20:24.000Z | Online Version

All applications come equipped with an Automatic Software Updater that appears upon start-up when a newer version of the
application is available. A sample of the Forensic Studio software update window is pictured below.  

You can launch the Software Update feature manually by selecting Check for Updates under the Help menu of your application.

Generating a Snapshot
Last updated: 2021-01-28T17:20:39.000Z | Online Version

Snapshots are still image products you can generate in all MotionDSP applications. To create a snapshot click on the Snapshot
button in the lower-right corner of the player. If your Product List is closed, you'll notice the product list icon will change color
indicating a new product has been created. 

11

https://help.motiondsp.com/hc/en-us/articles/360034511932-Automatic-Software-Updates
https://help.motiondsp.com/hc/en-us/articles/360034511932-Automatic-Software-Updates
https://help.motiondsp.com/hc/en-us/articles/360034511932-Automatic-Software-Updates
https://help.motiondsp.com/hc/en-us/articles/360034511932-Automatic-Software-Updates
https://help.motiondsp.com/hc/en-us/articles/360034511932-Automatic-Software-Updates
https://help.motiondsp.com/hc/en-us/articles/360034511932-Automatic-Software-Updates
https://help.motiondsp.com/hc/en-us/articles/360034511932-Automatic-Software-Updates
https://help.motiondsp.com/hc/en-us/articles/360034511932-Automatic-Software-Updates
https://help.motiondsp.com/hc/en-us/articles/360023098911-Generating-a-Snapshot
https://help.motiondsp.com/hc/en-us/articles/360023098911-Generating-a-Snapshot
https://help.motiondsp.com/hc/en-us/articles/360023098911-Generating-a-Snapshot
https://help.motiondsp.com/hc/en-us/articles/360023098911-Generating-a-Snapshot
https://help.motiondsp.com/hc/en-us/articles/360023098911-Generating-a-Snapshot
https://help.motiondsp.com/hc/en-us/articles/360023098911-Generating-a-Snapshot
https://help.motiondsp.com/hc/en-us/articles/360023098911-Generating-a-Snapshot
https://help.motiondsp.com/hc/en-us/articles/360023098911-Generating-a-Snapshot


r 

 

Right-click on this new product and select Save As
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Saving Snapshots has the following options
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1. Processed frame(s)
This will save a copy of your snapshot with processing applied. _enhanced will be appended to the filename

2. Original (unprocessed) frame(s)
This will save a copy of your snapshot without processing applied. _original will be appended to the filename

3. Merged original and processed frames
This will save a copy of both the processed and unprocessed products side by side in one file. _merged will be
appended to the filename 

4. Interpolation
Choose the interpolation method for creating a merged product

5. Save Region Only
When working with the Region of Interest tool in Forensic Studio or Forensic, selecting this option will save only the
area within the defined region 

6. Change snapshot image format
Options include: BMP, PNG, JPG, TIFF

GPU Support
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GPU Support
Last updated: 2021-01-28T17:20:55.000Z | Online Version

To enable real-time processing of video, our suite of applications have been optimized to leverage the additional processing
power available in modern GPUs using NVIDIA's CUDA technology. 

GPU-Accelerated Processing

-Offload filter processing and tracking to GPU resources

GPU-Accelerated Encoding

-Export H.264 video faster with GPU resources

TIPS:

MotionDSP applications only support NVIDIA GPUs with a minimum CUDA compute capability of 3.0 or higher.
You can specify which GPU to use for which workload in the GPU options menu if more than one GPU is installed on your
system.

Play Controls
Last updated: 2021-01-28T17:21:15.000Z | Online Version
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1. Start of Section/Video
 Return the playhead to the beginning of the video or
defined section (Ctrl+Home)

2. Previous Frame
 Move back one frame (Ctrl+<)

3. Reverse Playback (not available in Spotlight)
 Reverse playback at the set playback speed
(Backspace)

4. Playback Speed Options are: 1/8*, 1/4, 1/2, 1x, 2x, 4x

*Not available for export

5. Play/Pause
 Forward playback and pause (Space)

6. Next Frame
 Move forward one frame (Ctrl+>)

7. End of Section/Video
 Move the playhead to the end of the video or defined
section (Ctrl+End)

8. Loop
 Enable looping for the video or section (Ctrl+L)

9. Set Section Start
 Begin section at playhead ( Ctrl+[ )

10. Set Section End
 End section at playhead (Ctrl+] ) 

11. Reset Section
 Clear established section start and end points (Ctrl+\)

Set as Thumbnail feature
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Last updated: 2020-12-10T17:44:30.000Z | Online Version

A thumbnail is a small representation of an image that is used to identify a file by its contents intended to make it faster to
manage a group of larger images.

To create a thumbnail, create a snapshot of the image you would like to be displayed as the thumbnail and click "save to product
list".

The image will display in the Product list section as seen below:
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Right click on the desired snapshot and choose Set as Thumbnail
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Your updated thumbnail will be displayed in the Project Panel.
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Timeline Navigator
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Timeline Navigator
Last updated: 2021-01-28T17:21:29.000Z | Online Version

Some videos have a long duration that makes representing their timing on the Timeline too small. This can reduce precision
when trying to select another frame or scrub through a smaller section.

The example above shows the entire 11-minute video 

By dragging the Timeline Navigator handles inward the same video now only displays 4 minutes of video (minutes 4:00 - 8:00)

TIPS:

The zoomed section will move forward with the playhead as it reaches the end of the zoomed area but will retain its zoom
duration.

Trim Section
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Trim Section
Last updated: 2021-01-28T17:21:54.000Z | Online Version

Not every part of a video is as important as others. Sometimes you'd like to reduce the amount of a video that can be worked
with and exported. 

In the above example, the 11-minute video has been reduced to a working range from 4:00 - 6:00 using the Set Section In and
Set Section Out buttons and is defined by the blue bar.

TIPS:

The playhead can't leave the section when one is set.
When loop is enabled only the section is looped.
When a section is set, only that section will be exported

Projects
Last updated: 2021-01-28T17:22:08.000Z | Online Version

When you launch a MotionDSP application, you will be prompted to either create a new project or to open an existing project.
Projects can include one or more pieces of original video material (files) screen captured video and all enhanced snapshots and
videos. 

Every change you make to the settings (e.g., enhancements) is saved in the project and will be apparent the next time you open
the project. Projects can be saved manually by selecting the Save Project and Save (Export) Project As menu options in the File
menu. Projects are saved automatically on every change and after a user finishes working with that Project (by selecting New
Project, Open Project or Exit from the File menu).

The default location for all MotionDSP projects is a folder in your default videos folder (e.g., My Videos) in Windows. Project files
have an ".IPROJ" extension.

Importing files
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Importing files
Last updated: 2021-01-28T17:23:15.000Z | Online Version

To import an audio or video file from a local or networked drive, select File>Import Video> File, or press the File button in the
main toolbar, or drag-and-drop a video file into the Project Pane. 

Saving a product
Last updated: 2021-01-28T17:22:55.000Z | Online Version

There are two ways to save a product once you have finished enhancing or redacting.

First click on the VIDEO button: 

Then you will be presented with two options SAVE TO PRODUCT LIST or EXPORT FROM PROJECT:
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Save to Product List - This will create a product that will appear in your product list and remain in the project's folder

Export from Project - This will create a product outside of the project folder in a folder you define in the options menu. This
product will also appear in the product list as well as the project folder

Output File Format

Video:

-Uncompressed AVI

-Compressed AVI

-WMV

-H.264 MP4

-H.265 MP4*

Audio:

-MP3

-WMA

-AAC

-WAV

Compression†

-Determine video codec compression settings

Not available when Output File Format set to Uncompressed AVI

Bitrate†

-Set the exported video bitrate manually

Only available for H.264 MP4 with 'Custom' Compression settings
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Playback Speed†

-Adjust the exported video playback speed

-1/4x, 1/2x, 1x, 2x, 4x

Save Options†

-Save Original (Save the video with no Forensic or Spotlight
changes)

-Save Processed Video (Save the video with Forensic or Spotlight
changes)

-Save Merged Video (Save a video with the original and
processed version side-by-side)

-Save Both Processed and Merged (Save two videos: 1 Merged,
1 Processed - as described above)

Merge Interpolation†

-Bilinear is the recommended format for getting the best quality for
most videos.

-Nearest neighbor is a format widely used by rendering engines.

Save Region Only†

-Save only the area inside the Region of Interest

Forensic Only

Remove Audio†
-Checkbox to completely remove all audio layers from exported
video

Summary -Information about the video to be exported

*Only available with GPU

†Only available when exporting a video product

Generate a Report
Last updated: 2021-01-28T17:22:40.000Z | Online Version

If this is your first time generating a report please take the time to configure your report preferences in the
Tools>Options>Reports menu: 
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In order to generate a report, you must have two things

1. An original media file in the project panel
2. A Snapshot, Video, or Audio Product saved to the product list for the above media file.

Navigate to Tools>Generate Report (Current Video) and select.

Choose a save location, filename, and file type (PDF, RTF, XML) then save.

ScreenGrabber
Last updated: 2021-01-28T17:22:24.000Z | Online Version
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The ScreenGrabber application can record portions of the visible screen to a video file that can be processed by a MotionDSP
application. It is commonly used to import CCTV footage from proprietary formats by playing the videos in specialized players
and capturing the output.

The ScreenGrabber is installed in the MotionDSP application and can be invoked by the application or as a stand-alone
application. 

To start the ScreenGrabber as a stand-alone application click the Screen button at the top left corner under the menu.

 

ScreenGrabber has a very simplistic menu.  Before starting a capture, a user can configure the ScreenGrabber settings by
selecting the cog. Drag the corners around the video player or choose a common resolution and press record.

When your recording has finished press F9 and the video preview window will appear.
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Review for accuracy then press the checkmark and select to 'Open in Application' or 'Save As' and choose a save location

 

FAQ

How do I upgrade to a different MotionDSP product?
Last updated: 2021-01-28T17:44:02.000Z | Online Version

Our Sales Team will assist you with your request at Sales@MotionDSP.com 

I have not received my Product Key and Download
Last updated: 2021-01-28T17:43:30.000Z | Online Version

Your product key and download link should have been sent to you automatically. Please verify in your Spam and Junk folders
for email containing Download of software and product key from Support@motiondsp.com.  If you still cannot find it, please
reach out to support by emailing support@motiondsp.com and we will promptly resend your email. 

How do I add a Watermark?
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How do I add a Watermark?
Last updated: 2021-01-28T17:41:10.000Z | Online Version

Navigate to Tools, Options, Customs. Turn ON Enable Watermark.

Adjust Watermark Transparency [%]. No watermark will be visible if watermark transparency is set as 100%. As watermark
transparency % decreases, the more visible the watermark will be. 

How do I add a Logo on reports?
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How do I add a Logo on reports?
Last updated: 2021-01-28T17:41:00.000Z | Online Version

Navigate to Tools\Options\Reports. Enter Organization, select Set Organization Logo, upload logo, and turn ON Apply settings
to current project  

What file formats are supported?
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What file formats are supported?
Last updated: 2021-01-28T17:53:49.000Z | Online Version

The following formats are supported by our software types:

Snapshots

Videos

 

How does my subscription work?

31

https://help.motiondsp.com/hc/en-us/articles/360018033972-What-file-formats-are-supported-
https://help.motiondsp.com/hc/en-us/articles/360018033972-What-file-formats-are-supported-
https://help.motiondsp.com/hc/en-us/articles/360018033972-What-file-formats-are-supported-
https://help.motiondsp.com/hc/en-us/articles/360018033972-What-file-formats-are-supported-
https://help.motiondsp.com/hc/en-us/articles/360018033972-What-file-formats-are-supported-
https://help.motiondsp.com/hc/en-us/articles/360018033972-What-file-formats-are-supported-
https://help.motiondsp.com/hc/en-us/articles/360018033972-What-file-formats-are-supported-
https://help.motiondsp.com/hc/en-us/articles/360018033972-What-file-formats-are-supported-


r 

 

How does my subscription work?
Last updated: 2021-01-28T17:54:09.000Z | Online Version

You may learn more about the different subscriptions we have available and see which suits you best.

Subscription & Cancellation Policy

 

 

I receive an error when attempting to activate my product.
Last updated: 2021-01-28T17:27:43.000Z | Online Version

Automatic activation utilizes certain network ports and protocols that might be blocked under more restrictive networks or
completely unavailable on a computer not connected to the internet. If you experience either of these situations attempt an
Offline Activation on a computer with unrestricted internet access.  

Why can't I import my file?
Last updated: 2021-01-28T17:27:18.000Z | Online Version

Forensic, Spotlight, and Forensic Studio have native support for a number of video and audio formats and codecs. We also
heavily leverage the LAV Filters codec pack to expand our capabilities further. 

 

If you are trying to import audio or video in a proprietary codec you will need to contact the manufacturer for access to the codec.
In cases where the codec is not available, use ScreenGrabber.

General

Miscellaneous

Untitled

32

https://help.motiondsp.com/hc/en-us/articles/360018305551-How-does-my-subscription-work-
https://help.motiondsp.com/hc/en-us/articles/360018305551-How-does-my-subscription-work-
https://help.motiondsp.com/hc/en-us/articles/360018305551-How-does-my-subscription-work-
https://help.motiondsp.com/hc/en-us/articles/360018305551-How-does-my-subscription-work-
https://help.motiondsp.com/hc/en-us/articles/360018305551-How-does-my-subscription-work-
https://help.motiondsp.com/hc/en-us/articles/360018305551-How-does-my-subscription-work-
https://help.motiondsp.com/hc/en-us/articles/360018305551-How-does-my-subscription-work-
https://help.motiondsp.com/hc/en-us/articles/360018305551-How-does-my-subscription-work-
https://www.motiondsp.com/subscription-and-cancellation-policies
https://www.motiondsp.com/subscription-and-cancellation-policies
https://www.motiondsp.com/subscription-and-cancellation-policies
https://www.motiondsp.com/subscription-and-cancellation-policies
https://www.motiondsp.com/subscription-and-cancellation-policies
https://www.motiondsp.com/subscription-and-cancellation-policies
https://www.motiondsp.com/subscription-and-cancellation-policies
https://www.motiondsp.com/subscription-and-cancellation-policies
https://help.motiondsp.com/hc/en-us/articles/360016561092-I-receive-an-error-when-attempting-to-activate-my-product-
https://help.motiondsp.com/hc/en-us/articles/360016561092-I-receive-an-error-when-attempting-to-activate-my-product-
https://help.motiondsp.com/hc/en-us/articles/360016561092-I-receive-an-error-when-attempting-to-activate-my-product-
https://help.motiondsp.com/hc/en-us/articles/360016561092-I-receive-an-error-when-attempting-to-activate-my-product-
https://help.motiondsp.com/hc/en-us/articles/360016561092-I-receive-an-error-when-attempting-to-activate-my-product-
https://help.motiondsp.com/hc/en-us/articles/360016561092-I-receive-an-error-when-attempting-to-activate-my-product-
https://help.motiondsp.com/hc/en-us/articles/360016561092-I-receive-an-error-when-attempting-to-activate-my-product-
https://help.motiondsp.com/hc/en-us/articles/360016561092-I-receive-an-error-when-attempting-to-activate-my-product-
https://help.motiondsp.com/hc/en-us/articles/360019933212-Offline-Activation
https://help.motiondsp.com/hc/en-us/articles/360019933212-Offline-Activation
https://help.motiondsp.com/hc/en-us/articles/360019933212-Offline-Activation
https://help.motiondsp.com/hc/en-us/articles/360019933212-Offline-Activation
https://help.motiondsp.com/hc/en-us/articles/360019933212-Offline-Activation
https://help.motiondsp.com/hc/en-us/articles/360019933212-Offline-Activation
https://help.motiondsp.com/hc/en-us/articles/360019933212-Offline-Activation
https://help.motiondsp.com/hc/en-us/articles/360019933212-Offline-Activation
https://help.motiondsp.com/hc/en-us/articles/360016559852-Why-can-t-I-import-my-file-
https://help.motiondsp.com/hc/en-us/articles/360016559852-Why-can-t-I-import-my-file-
https://help.motiondsp.com/hc/en-us/articles/360016559852-Why-can-t-I-import-my-file-
https://help.motiondsp.com/hc/en-us/articles/360016559852-Why-can-t-I-import-my-file-
https://help.motiondsp.com/hc/en-us/articles/360016559852-Why-can-t-I-import-my-file-
https://help.motiondsp.com/hc/en-us/articles/360016559852-Why-can-t-I-import-my-file-
https://help.motiondsp.com/hc/en-us/articles/360016559852-Why-can-t-I-import-my-file-
https://help.motiondsp.com/hc/en-us/articles/360016559852-Why-can-t-I-import-my-file-
https://help.motiondsp.com/hc/en-us/articles/360018032252-Install-LAV-Filters
https://help.motiondsp.com/hc/en-us/articles/360018032252-Install-LAV-Filters
https://help.motiondsp.com/hc/en-us/articles/360018032252-Install-LAV-Filters
https://help.motiondsp.com/hc/en-us/articles/360018032252-Install-LAV-Filters
https://help.motiondsp.com/hc/en-us/articles/360018032252-Install-LAV-Filters
https://help.motiondsp.com/hc/en-us/articles/360018032252-Install-LAV-Filters
https://help.motiondsp.com/hc/en-us/articles/360018032252-Install-LAV-Filters
https://help.motiondsp.com/hc/en-us/articles/360018032252-Install-LAV-Filters
https://help.motiondsp.com/hc/en-us/articles/360018305491-ScreenGrabber
https://help.motiondsp.com/hc/en-us/articles/360018305491-ScreenGrabber
https://help.motiondsp.com/hc/en-us/articles/360018305491-ScreenGrabber
https://help.motiondsp.com/hc/en-us/articles/360018305491-ScreenGrabber
https://help.motiondsp.com/hc/en-us/articles/360018305491-ScreenGrabber
https://help.motiondsp.com/hc/en-us/articles/360018305491-ScreenGrabber
https://help.motiondsp.com/hc/en-us/articles/360018305491-ScreenGrabber
https://help.motiondsp.com/hc/en-us/articles/360018305491-ScreenGrabber


r 

 

Untitled
Last updated: 2021-05-19T20:15:02.000Z | Online Version

Ikena Measure Tool
Last updated: 2021-01-28T17:17:03.000Z | Online Version

Perpetual customers who purchased Ikena Forensic Pro can download Ikena Measure below:

Download Ikena Measure 

Downloading Legacy Installers
Last updated: 2021-08-16T12:33:00.000Z | Online Version

Legacy MotionDSP installers are available for download to perpetual license holders with expired product maintenance.
Perpetual license holders are able to use any product version installed before their product maintenance expiration date.

Note: Ikena Forensic + Spotlight Bundle and Ikena Pro Bundle customers should download the Forensic Installer

Forensic Studio:

Forensic Studio 8.1 - November 14, 2018
Forensic Studio 8.3 - May 9, 2019
Forensic Studio 8.4 -  July 18, 2019
Forensic Studio 8.5 - September 11, 2019
Forensic Studio 8.6 - December 4, 2019
Forensic Studio 8.7 - February 19, 2020
Forensic Studio 8.8 - May 15, 2020
Forensic Studio 8.9 - November 20, 2020
Forensic Studio 8.10 - March 12, 2021
Forensic Studio 9.0 - August 13, 2021

Forensic:
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Ikena Forensic 6.4 - December 20, 2016
Ikena Forensic 7.1 - July 6, 2017
Ikena Forensic 7.4 - December 11, 2017
Ikena Forensic 8.0 - July 27, 2018
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Forensic 8.5 - September 11, 2019
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Forensic 8.10  - March 12, 2021
Forensic 9.0  - August 13, 2021

Spotlight:

Ikena Spotlight 6.1 - May 5, 2016
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Ikena Spotlight 7.1 - July 6, 2017
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Spotlight 8.5 - September 11, 2019
Spotlight 8.6 - December 4, 2019
Spotlight 8.7 - February 19, 2020
Spotlight 8.8  - May 15, 2020
Spotlight 8.9 - November 20, 2020
Spotlight 8.10 - March 12, 2021
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Downloading the Forensic Studio Installer
Last updated: 2021-08-28T00:06:22.000Z | Online Version

Click here to download the Forensic Studio 9.2 Installer

Forensic Studio requires the LAV Filters open-source codec pack that can play most commonly-available video files.

 NOTE:

Using other third-party codecs may degrade results.
If you choose not to install the codec pack, a typical Windows machine will only be able to open a small range of video
files, for example, MPEG2 and H264 video files, and Windows Media (WMV)

Downloading the Forensic Installer
Last updated: 2021-08-16T12:27:52.000Z | Online Version

Click here to download the Forensic 9.0 Installer

Forensic requires the LAV Filters open-source codec pack that can play most commonly-available video files.

 NOTE:

Using other third-party codecs may degrade results.
If you choose not to install the codec pack, a typical Windows machine will only be able to open a small range of video
files, for example, MPEG2 and H264 video files, and Windows Media (WMV)

Downloading the Spotlight Installer
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Downloading the Spotlight Installer
Last updated: 2021-08-16T12:26:54.000Z | Online Version

Click here to download the Spotlight 9.2 Installer

Spotlight requires the LAV Filters open-source codec pack that can play most commonly-available video files.

 NOTE:

Using other third-party codecs may degrade results.
If you choose not to install the codec pack, a typical Windows machine will only be able to open a small range of video
files, for example, MPEG2 and H264 video files, and Windows Media (WMV)

Announcements

Cubic | MotionDSP Beta Test Program
Last updated: 2021-01-28T17:38:08.000Z | Online Version

We are excited to extend an invitation to our new Beta Program. The purpose of the Beta Program is to enable us to develop
and deliver the highest quality applications with the features you need. The program begins with an early preview of new
Forensic and Spotlight features not yet available to the public.  Participation in the Beta Program is voluntary, however, feedback
and input resulting from your early access will be invaluable to the ongoing development of features that really matter to users
like yourself.

Participants will be asked to complete 2 short, electronic surveys delivered over 60 days, plus attend at least one 30 minute
focus group discussion or 1-on-1 call so that we can best understand your needs, requirements, and experience resulting from
the early release.

If you’re interested in joining the Beta Program, sign up here and a Customer Service Representative will be in touch to provide
access to the latest software download and more details about the program.

Troubleshooting

Application

Why can't I open Deblur?
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Why can't I open Deblur?
Last updated: 2021-01-28T17:27:55.000Z | Online Version

In order to launch Deblur there must be a file for it to open. Select a video from the project pane to open it in the Workspace,
after which you can select the Deblur button. 

No Video Loaded - Deblur Unavailable Video Loaded - Deblur Available

What's the difference between exporting and saving to      
product list?
Last updated: 2021-01-28T17:38:47.000Z | Online Version

Save to Product List - This will create a product that will appear in your product list and remain in the project's folder 

Export from Project - This will create a product outside of the project folder in a folder you define in the options menu. This
product will also appear in the product list as well as the project folder

I've applied filters but don't see any changes
Last updated: 2021-01-28T17:27:00.000Z | Online Version
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1. Make sure the Apply Processing button above the filters is turned on. (Blue)

Processing On Processing Off

2. Choose the Compare/Switch tool to see Before/After processing side-by-side

3. Use your scroll wheel to zoom in on the image, some changes are subtle 

Why can't I open Spotlight in Forensic Studio?
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Why can't I open Spotlight in Forensic Studio?
Last updated: 2021-01-28T17:28:03.000Z | Online Version

In order to launch Spotlight there must be a video for it to open. Select a video from the project pane to open it in the
Workspace, after which you can select the Spotlight button. 

No Video Loaded - Spotlight Unavailable Video Loaded - Spotlight Available

Why is Super-Resolution limited to 2 or 3?
Last updated: 2021-01-28T17:38:17.000Z | Online Version

Super-Resolution can only generate products as large as the available export size. For this reason, you will see the Super-
Resolution options reduced to 2 or 3 for video with a resolution larger than 1280 x 720 

Video & Audio

Why can't I import my video/audio?
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Why can't I import my video/audio?
Last updated: 2021-08-01T17:26:22.000Z | Online Version

Forensic, Spotlight, and Forensic Studio have native support for a number of video and audio formats and codecs. We also
heavily leverage the LAV Filters codec pack to expand our capabilities further. 

If you are trying to import audio or video in a proprietary codec you will need to contact the manufacturer for access to the codec.
In cases where the codec is not available, use ScreenGrabber.

What's the difference between a container and a codec?
Last updated: 2021-01-28T17:42:42.000Z | Online Version

A codec is a way to code (encode) and decode digital data such as a video file. It compresses the stream to reduce file size
before it is transmitted to make the video playable on devices.

The container defines the structure and content of the file which can audio or video. Some containers are limited to audio, photo
or video only, or combination of audio and video. 

 

 

License

What is a Hardware license?
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What is a Hardware license?
Last updated: 2021-06-21T14:55:58.000Z | Online Version

Hardware dongles are only available to annual and multi-year subscribers. We do not provide this option for monthly
subscribers. 

 

The Sentinel hardware dongle already contains an activated license which is encrypted, so you will not see any files on the
dongle. It is "Plug and Play", so you will not be prompted for activation. Insert the dongle in the USB port and launch the
software. 

 

If you  do not see a red light displayed on the USB dongle, try a different USB port or update the driver so that your computer
can successfully communicate with the dongle.

 

Since the dongle contains an activated license, please keep the dongle in a safe place. There is a nominal fee of $250 per
dongle for a replacement.

What is a Software License
Last updated: 2021-06-21T14:56:15.000Z | Online Version

Software License is available to monthly, annual, and multi-year subscribers.

 

You should receive a download install and product key via email. Please check your junk/spam folder and ensure that your
email address is correct. 

 

Your product key is good for one redemption of a software license using the automatic activation on the first launch of your
application or using the Offline Activation. 

After activation, the software license is tied to the hardware on which you activated it. If your application becomes inactivated,
you can reactivate the same hardware using your original V2C file.

If you need to move your license to another computer, use the rehosting instructions.

Please take care when redeeming or making changes to your application workstation. Refunds or replacements will not be
provided for lost or misplaced licenses.

For more information about licenses on your workstation, use the Sentinel Admin Control Center.
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Click here for steps to re-host license 
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Activate Button is not Active
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Activate Button is not Active
Last updated: 2020-06-23T17:42:46.000Z | Online Version

Please confirm that there is no extra space in front of the password and/or extra space after the password.  The activate button
will become available when the correct number of characters are entered for the product key.

 

Error message when activating license

44

https://help.motiondsp.com/hc/en-us/articles/360044601112--Activate-Button-is-not-Active
https://help.motiondsp.com/hc/en-us/articles/360044601112--Activate-Button-is-not-Active
https://help.motiondsp.com/hc/en-us/articles/360044601112--Activate-Button-is-not-Active
https://help.motiondsp.com/hc/en-us/articles/360044601112--Activate-Button-is-not-Active
https://help.motiondsp.com/hc/en-us/articles/360044601112--Activate-Button-is-not-Active
https://help.motiondsp.com/hc/en-us/articles/360044601112--Activate-Button-is-not-Active
https://help.motiondsp.com/hc/en-us/articles/360044601112--Activate-Button-is-not-Active
https://help.motiondsp.com/hc/en-us/articles/360044601112--Activate-Button-is-not-Active


r 

 

Error message when activating license
Last updated: 2021-01-28T17:41:36.000Z | Online Version

Navigate to localhost:1947 on your chosen web browser URL. If you are not able to access Sentinel Admin Control Center,
please ensure that there's no Firewall or antivirus program blocking port 1947. 
Verify that there's no security restrictions placed on the AppData folder.
If you're able to complete the above steps, please reach out to Support@MotionDSP.com

Understanding the Software License
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Understanding the Software License
Last updated: 2021-01-28T17:40:00.000Z | Online Version

Your product key is good for one redemption of a software license using the automatic activation on the first launch of your
application or using the Offline Activation. 

After activation, the software license is tied to the hardware on which you activated it. If your application becomes inactivated,
you can reactivate the same hardware using your original V2C file.

If you need to move your license to another computer, use the rehosting instructions.

Please take care when redeeming or making changes to your application workstation. Refunds or replacements will not be
provided for lost or misplaced licenses.

For more information about licenses on your workstation, use the Sentinel Admin Control Center.

Offline Activation
Last updated: 2021-05-25T13:37:37.000Z | Online Version

If you are unable to automatically activate your product using a product key at the application launch use the following, with
Application Workstation (AW) being the computer with MotionDSP software installed, and Network Workstation (NW) being the
computer with internet access. 

If your workstation has internet access and can reach https://activate.motiondsp.com, ignore the AW, NW markings and perform
all steps on the singular workstation.

(AW) Open the License Manager application, available in the MotionDSP Start Menu Folder, and choose the 'Installation of
a new protection key' under the Collect Status Information tab.
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(AW) Choose a filename and save location (like a flash drive) that you can transfer to the Network Workstation (NW)

(NW) Navigate to https://activate.motiondsp.com and enter a product key.
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(NW) Click Offline Activation - If you do not see these buttons, click here

(NW) Attach C2V file transferred from the Application Workstation and select Generate
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(NW) Download the V2C File and choose a save location (like a flash drive) that you can transfer to the Application
Workstation (AW)
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(AW) Return to the License Manager application and select the second tab, Apply License File. 1: Attach the V2C file
transferred from the Network Workstation 2: Apply the update

 

The license has been written to the Application Workstation
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If you are using the application on a computer that required Offline Activation, please submit a request using the Help Center so
that future updates to your subscription can be sent to you via email.

 

Downloading your V2C file from a previous activation
Last updated: 2021-01-28T17:40:44.000Z | Online Version

Navigate to https://activate.motiondsp.com and enter your product key 
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Click view next to Previous Activations

Download the V2C file by clicking V2C file

52



r 

 

Open the License Manager application, available in the MotionDSP Start Menu folder and choose the second tab, Apply
License File. 1: Attach your V2C file 2: Apply your V2C file

Your license is now attached
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If you're having trouble attaching your previous activation to the same workstation you initially activated, please submit a support ticket. If you're trying to move your license to another workstation please see

instructions on Rehosting

Rehosting a Software License
Last updated: 2021-01-28T17:38:25.000Z | Online Version

You can use the License Manager application (C:\Program Files\MotionDSP\PRODUCTNAME) to transfer your license from one
computer, the Source Computer (SC) to another, the Recipient Computer (RC). This procedure uses the License Manager on
both computers so you will need to install your MotionDSP Product on the Recipient Computer before beginning. You can find
your applicable MotionDSP Installer here 
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(RC) Open the License Manager application and follow Step 1 on the Transfer License tab
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(SC) Transfer the Recipient Computer .id file to the Source Computer and launch the License Manager

1. Select the license you'd like to transfer
2. Attach the .id file you created on the Recipient Computer
3. Select a location to create the .h2h license transfer file
4. Select Generate License Transfer File
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(RC) Transfer the .h2h file to the Recipient Computer and attach using the second tab of the License Manager.

1. Select .h2h file created on the Source Computer
2. Verify computer names are accurate
3. Apply License to Recipient Computer

Discontinue your subscription
Last updated: 2021-01-28T17:39:32.000Z | Online Version

If you're interested in canceling your subscription, please submit a cancellation request. 

 

Cancellation requests received less than 5 days before the end of your current subscription period will apply to the next
subscription period per the Subscription & Cancellation Policy

 

FAQ
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Forensic Studio-Forensic and Spotlight Keyboard Shortcuts
Last updated: 2021-06-16T16:51:13.000Z | Online Version

 

Click on links below for PDF versions 

 

Forensic Studio-Forensic Keyboard Shortcuts

 

Spotlight Keyboard Shortcuts  

 

 

Download Knowledge Base PDF
Last updated: 2021-01-28T18:03:03.000Z | Online Version

Click here to download the Knowledge Base PDF

Forensic

Forensic Training Videos

MotionDSP Forensic, Spotlight, and Forensic Studio: Re    
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Set as Thumbnail feature
Last updated: 2021-01-05T18:31:07.000Z | Online Version

A thumbnail is a small representation of an image that is used to identify a file by its contents intended to make it faster to
manage a group of larger images.

 

To create a thumbnail, create a snapshot of the image you would like to be displayed as the thumbnail and click "save to product
list".
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The image will display in the Product list section as seen below:

75



r 

 

Right click on the desired snapshot and choose Set as Thumbnail
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Your updated thumbnail will be displayed in the Project Panel.
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Compare/Split
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Compare/Split
Last updated: 2021-01-28T17:26:28.000Z | Online Version

Use the Compare/Split option to see the Before/After processing view of your video. This feature is helpful to see how your filter
options compare to the original. 

TIPS:

You can click and drag the center divider to show more of the Before or After section.

Deblurring Tool
Last updated: 2021-07-03T14:35:22.000Z | Online Version

The Deblurring Tool is designed to reduce blur artifacts caused by defocus or motion using fewer parameters and multiple
outputs. 

1. Pause the video and click the Deblur button.
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2. Deblurring tool interface will launch and automatically calculate estimated values for  Lambda Weight and Kernal Size.
Make changes based on parameter descriptions below. Click Next

3. The Deblurring tool will produce variations on your source image using the provided parameters and display them on the
left. Wait for processing to complete and select the best image. If none of the images are acceptable click Show Original to
go back and adjust the parameters.

4. Click Save when acceptable results are produced.

Parameters
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Lambda Weight

Most values are usually between 0-10. Start
with the automatically calculated estimate.
For lighter images, lambda will usually be
lower.

Kernel Size

Start with the automatically calculated
estimate. Increase the kernel size if the image
is not deblurred enough. Decrease the kernel
size if significant artifacts are created.

TIPS:

Use the Toggle Ringing ON/OFF switch to reduce the ring artifacts created by the deblurring tool during processing

Filters

Input Setup Filter
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Input Setup Filter
Last updated: 2021-06-22T17:15:47.000Z | Online Version

The Input Setup Filter   Allows the user to reduce or enlarge the resolution and or aspect ratio of the project file such
that the output will match this new resolution or aspect ratio setting.

 

Resize Input: This setting gives the user options to change the output video resolution, for example the project file's source
resolution might be 720p and using the 1080p setting will increase the working and output resolution to 1080p.

 

 

Aspect ratio: A proportional relationship between an image's width and height describing an image's shape. Aspect ratios are
written as a formula of width to height, like this: 4:3.  This setting allows the user to change the project files working and output
aspect ratio.

Perspective Filter
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Perspective Filter
Last updated: 2020-12-10T15:20:18.000Z | Online Version

Our perspective filter allows arbitrary stretching of part of an image to correct the perspective and includes the ability to leverage
our other filters such as our multi-frame super resolution to achieve great results. 

 

 

In the image below, the perspective filter was used to display a frontal view of an angled license plate in addition to using other
filters to receive greater results.

Deinterlacing
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Deinterlacing
Last updated: 2021-01-28T17:24:10.000Z | Online Version

Some video sources output an interlaced video signal. Each frame is split into odd and even horizontal scan lines called fields
which are sampled at different time instances. This effectively results in doubling the frame rate without increasing bandwidth
requirements. To eliminate “combing” artifacts which are produced by interlaced frame acquisition, the deinterlacing
enhancement should be used. 

Low     

 

Low is the fastest and the least accurate. With this setting,
deinterlacing is performed by discarding the odd field and
upscaling the even field to fit the video’s vertical resolution.
The processing uses a bicubic interpolation algorithm to
upscale the even field.

Medium     

 

Medium is more computationally demanding and produces
better results. With this setting, deinterlacing is performed by
discarding the odd field and upscaling the even field to fit the
video’s vertical resolution. The processing uses a more
advanced algorithm, known as kernel regression, to upscale
the even field. The edge-preserving properties of the kernel
regression algorithm is able to handle slant edges better than
the bicubic interpolation used by the Low setting.

High     

 

High uses both odd and even fields to perform deinterlacing.
If used in combination with Resolution enhancement, this
setting instructs Multi-Frame Super-Resolution processing to
use both odd and even fields.

Tips:

1. Low and Medium settings may yield better results for deinterlacing videos showing a scene with non-rigid objects with
uneven lines and textures, like people and animals.

2. Using High setting with Resolution enhancement may result in a significant drop in processing bandwidth

Deblurring Filter
Last updated: 2021-06-22T17:15:34.000Z | Online Version

Deblurring Filter Removes distortion from blurry and noisy artifacts of images caused by defocus aberration or motion blur.  
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Focus   

 

Higher values will increase the influence of pixels which are far away, thus causing the frame to look blurry for
the highest value. Lower values will decrease the influence of pixels which are far away.

Level   

 

You can change the amount of deblurring enhancement by moving this slider from 0 (no change in contrast) to
200 (maximum deblurring enhancement). 

Motion
Deblurring 
  

 

Removes the blur associated with linear motion

Intensity   
 

 

Lower values will have more of a deblurring effect in flat regions, but textured regions will become blurry.
Higher values will have less of a deblurring effect in flat regions, but better edge and corner reconstruction in
textured regions.

Angle 

 
Directional angle of the blur

Denoise   

 

Tune processing algorithms used to adjust the smoothness (i.e. the amount of noise/texture) of the final
reconstructed image. 
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Camera
Type  

 

Disk: Produces a denser middle and gradually fades out moving away from
center.  Images of unfocused lights have sharply defined edges whereby
the convolution kernel, or Point Spread Function (PSF) is disk
shaped.

 

Gauss: Produced by convolving the image with a
convolution kernel following a discrete approximation to a Gaussian
distribution with normalized area. The operation is popular
because it can be done relatively quickly due to fact that the two
dimensional convolution is separable into horizontal and vertical
one dimensional convolutions.

Crop
Last updated: 2021-01-28T17:28:50.000Z | Online Version

Video can be cropped to desired dimensions by using Crop enhancement. The amount of crop can be specified by setting the
percentage of video size or by specifying each crop border independently. Your preferred method can be chosen with the
Custom Crop button. To assist cropping, Forensic displays cropping guidelines that are visible only if Apply Enhancements
button is turned off. You can also manually adjust these using the cropping mouse mode button on the upper left of the
workspace. 

Resolution
Last updated: 2021-05-25T14:50:36.000Z | Online Version

The Resolution Enhancement tab is used to control the Multi-Frame Super-Resolution processing. It provides an effective means
for increasing the native video resolution by utilizing information redundancy between successive frames in a video. 

Applications and benefits include:

noise reduction
suppression of atmospheric distortions (mirage-like wobbling)
reduction of compression blocking artifacts
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Resolution Filter - Compact Resolution Filter - Expanded

 

Frames     

 

This slider controls the number of successive frames used by
the algorithm. The maximal number of frames can be set by
going to Tools > Options > Processing > Cache Size

Super Resolution     

 

This combo box is used to set the upscale factor applied to
the input frame by the Multi-Frame Super-Resolution
algorithm. Available options depend on the input resolution
and can be 1x, 2x, 3x, or 4x.

For example, applying a Super-Resolution factor of 2x to an
input video with a resolution of 320x240 results in a video with
a resolution of 640x480.

Fusion     

 

This slider controls the suppression of outlier-related
processing artifacts. The first phase of the Super-Resolution
algorithm is motion estimation between successive frames.
However, this can generate ghosting artifacts in some cases.
The Fusion parameter can reduce ghosting

Accuracy     

 

This slider can be used to control the tradeoff between
sharpness and noise suppression. Settings range from 0
(maximum noise suppression) to 1 (maximum sharpness)

ROI Mode This button allows the user to enhance, preview, and save the
ROI with a wider range of Super-Resolution (upscale) factors.

NOTE: The maximum output video size is 1080p. Hence higher resolution video has a lower available Super-Resolution factor.
However, a larger Super-Resolution factor can be set by limiting the video with ROI mode or cropping the video.

Tips: 
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1. To enhance the precision of the motion estimation, select an ROI which doesn’t contain outliers.
2. Choosing the appropriate Frames value can be challenging. The optimal value depends on the desired performance,

Super-Resolution upscale factor, and scene dynamics. For static scenes, the best results are achieved by setting the
Frames value to 9 or higher and the Super Resolution set to 2x.

3. With dynamic scenes, it’s best to start at the lowest setting and work your way up. With static scenes, it’s best to start high
and work your way down.

4. Super Resolution yields the best results for static scenes when used in conjunction with Deblurring.

 

Light & Color
Last updated: 2021-01-28T17:39:52.000Z | Online Version

The Light & Color enhancement makes it possible to reduce the effects of extreme color and light changes on image quality. 

Light & Color - Compact Light & Color - Expanded
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Auto Levels     

 

This button auto-adjusts the lighting levels of the video. For
manual adjustments use the Shadows and Highlights sliders.

Gamma     

 

This slider controls the "gamma correction". The value of “1.00”
means that the input and output frames are identical in terms of
“gamma correction”.

Saturation     

 

This slider controls the color saturation. 100% means that the
saturation remains unchanged.

Auto White Balance     

 

This button turns auto-adjustment of the “white balance”
ON/OFF. For manual adjustments use the “Color” slider.

 

 

Automatic Brightness
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Automatic Brightness
Last updated: 2021-01-28T17:44:20.000Z | Online Version

The automatic brightness filter is designed to adjust to dynamic brightness changes in your video using a unique implementation
of MotionDSP's dehazing algorithm. Automatic Brightness is able to enhance in real-time with accuracy. 

Automatic Brightness - Compact Automatic Brightness - Expanded

Strength The level of brightness to be applied.

Radius Defines locality of the algorithm (impact of neighbor pixels). This is a Radius for The Median Filter.

Quality

Determines level of sub-sampling of the input frame, i.e., it tells by how much the input frame is reduced
and then processed:
          l ow means 4 times per each dimension
          m edium is twice for each dimension
          h igh does not reduce it at all

  

Contrast
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Contrast
Last updated: 2021-01-28T17:24:20.000Z | Online Version

The type of sensor and lighting conditions both impact video fidelity. In either case, the quality of the video can be improved by
adjusting the lighting in the video. Forensic has an advanced algorithm for contrast-limited adaptive histogram equalization. 

This process uses algorithms for automatic contrast adjustments in a single frame and across multiple frames to simulate the
effect of a longer exposure time. This has the effect of both suppressing noise and revealing new detail within the image/video.

Contrast - Compact Contrast - Expanded

 

Level     

 

You can change the amount of contrast enhancement by moving
this slider from 0 (no change in contrast) to 200 (maximum
contrast enhancement). The default value for this parameter is
30.

Sensitivity     

  

When the Sensitivity level is set at 1, the contrast enhancement
is applied to the entire frame as a whole. Higher settings enable
the processing algorithm to work on smaller regions in a frame.
For example, at a setting of 5, the contrast enhancement is
applied to the individual histograms in each of the 25 regions
within a transparent 5x5 grid within the image.

Stretch     

   

This parameter defines how much to stretch the processing
algorithm for significant contrast variations in the image. A larger
Stretch is good for resolving details in the shadows. A lower
Stretch works better for relatively even light distribution. The
range for the stretch parameter is [0-1].

Denoising
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Denoising
Last updated: 2021-01-28T17:23:51.000Z | Online Version

The Denoising enhancement panel allows you to tune processing algorithms used to adjust the smoothness (i.e. the amount of
noise/texture) of the final reconstructed image. 

Denoising - Compact Denoising - Expanded

 

Intensity     

 

Lower values will have more of a denoising effect in flat
regions, but textured regions will become blurry. Higher values
will have less of a denoising effect in flat regions, but better
edge and corner reconstruction in textured regions.

Focus     

 

Higher values will increase the influence of pixels which are
far away, thus causing the frame to look blurry for the highest
value. Lower values will decrease the influence of pixels
which are far away.

Scale     

 

This parameter is used to upscale the image resolution,
similar to the Super Resolution parameter in the Resolution
filter. Available options depend on the input resolution and
can be 1x, 2x, 3x, or 4x. For example, applying a Scale factor
of 2x to an input video with a resolution of 320x240 results in
a video with a resolution of 640x480.

Sharpen
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Sharpen
Last updated: 2021-01-28T17:24:01.000Z | Online Version

This enhancement uses Unsharp Masking, a well-known filter in image processing. It emphasizes the contrast of small details
(edges of objects) in the video frame. 

Sharpen - Compact Sharpen - Expanded

 

Intensity     

 

Defines how much the edges will be pronounced on a
processed image.

Focus     

 
Defines the radius of the unsharp masking algorithm in pixels.

NOTE: This filter does not add any information to the image, as is the case with super resolution or deblurring filters.

Stabilization

93

https://help.motiondsp.com/hc/en-us/articles/360018119432-Sharpen
https://help.motiondsp.com/hc/en-us/articles/360018119432-Sharpen
https://help.motiondsp.com/hc/en-us/articles/360018119432-Sharpen
https://help.motiondsp.com/hc/en-us/articles/360018119432-Sharpen
https://help.motiondsp.com/hc/en-us/articles/360018119432-Sharpen
https://help.motiondsp.com/hc/en-us/articles/360018119432-Sharpen
https://help.motiondsp.com/hc/en-us/articles/360018119432-Sharpen
https://help.motiondsp.com/hc/en-us/articles/360018119432-Sharpen


r 

 

Stabilization
Last updated: 2021-01-28T17:28:40.000Z | Online Version

The Stabilization enhancement panel allows you to tune the algorithms used to reduce shaking and unwanted movement in the
video 

Stabilization - Compact Stabilization - Expanded

 

Zoom     

 

Increasing this parameter zooms in on the video frame
content, effectively hiding black borders.

Auto Crop     

 

Turning this option on will suppress black borders, but as a
consequence may reduce the effect of stabilization.

Ignore Panning     

 

This button optimizes the stabilization function during extreme
panning motions or when the platform’s sensor is panning for
an extended period of time.

Body Cam     

 

 This button optimizes for the stabilization of low-frequency
shake such as that of a body cam

TIPS:

1. For the best possible stabilization, turn off Auto Crop. If the black borders are distracting increase the Zoom level. Frames
will be zoomed in and stabilization quality will be retained.

2. When the most important priority is to exclude black border pixels, turn on Auto Crop. If the stabilization quality is poor,
increase the Zoom level.

Region of Interest
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Region of Interest
Last updated: 2021-01-28T17:28:30.000Z | Online Version

Forensic has the option to process only a selected area--or "region of interest" (ROI)--of the original video. This is useful to
improve processing speed, and can also allow the enhancement algorithms to generate better results in a limited area when the
video frame contains significant light and color variations. 

The ROI can be moved and resized using the corners when the ROI tool is selected. For more accurate control use the options
available in the ROI filter

Left - Top left corner pixel location on the X-axis

Top - Top left corner pixel location on the Y-axis

Width - Total width of the ROI

Height - Total height of the ROI

False Color
Last updated: 2021-01-28T17:28:21.000Z | Online Version

False Color can be used to change the color palette of the video display. Under some viewing conditions this may result in better
perception of fine details. 
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Invert - Substitutes colors with their complements. Used on IR feeds, this mode effectively switches between “Black-Hot”
and “White-Hot” output.

Jet - Uses video luma component and represents it as a Jet false color map. As a result, variations in luminance - contrast
are translated into color hue variations.

Manual Offset - Adds the offset to each RGB component and clips the values to 0 - 255. You set the offset via the slider.
Offset range = [-255, 255], default offset is 0.

Manual Stretch - Adds the offset and scales to each RGB component. You set the Minimum Clip Value and the Maximum
Clip Value, similar to the Light & Color manual mode. The clip range = [0, 255], the default Minimum Clip Value is 0; the
default Maximum Clip Value is 255.
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Radial Distortion
Last updated: 2021-01-28T17:28:12.000Z | Online Version

This enhancement simplifies the process of correcting optical distortion caused by a camera lens. 

There are two modes for this filter. Manual mode allows you to make adjustments to improve the image when the camera type is
not known. The Camera Presets mode allows you to automatically apply the filter for commonly known commercial camera
types.

Manual Mode
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Main

 

Specifies the amount of spherical correction
that may be introduced. Positive values
make the image convex while negative ones
make it concave. The whole effect is similar
to wrapping the image inside or outside a
sphere.

Edge

 

Specifies the amount of additional spherical
correction at image edges.

X Shift, Y Shift

 

These two options specify the shift of the
image produced by not perfectly centered
pairs of lenses. This option produces visible
results only if the Main or Edge options are
non zero.

Zoom

 

Specifies the amount of the image
enlargement or reduction caused by the
hypothetical lens.

Camera Presets Mode

This mode enables you to quickly select presets for correcting potential radial distortion effects caused by a specific lens. In
order to correct the potential lens distortion, you need to know the camera make & model and/or the lens model & focal length.

 

Apply Processing
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Apply Processing
Last updated: 2021-01-28T17:27:09.000Z | Online Version

Click the Apply Enhancements button on the top to view the enhanced results of the video opened in the selected Workspace
“on-the-fly” as you adjust enhancement settings. (Your original video file will never be modified.) 

Apply Processing - Enabled Apply Processing - Disabled

 

NOTE: Applying enhancements “on-the-fly” requires more processing power, so—depending on the responsiveness of your
system—you may prefer to leave Apply Enhancements ‘ON’ at all times, or you may prefer to only periodically toggle Apply
Enhancements when you want to view the enhancement results.

Getting the best results with Forensic
Last updated: 2021-01-28T17:40:16.000Z | Online Version

Video enhancement is generally more effective on a clean video source. Ideally, users should import a video in its natively-
captured format - that is, the file as it was transferred right from the camera or sensor. 

A video that has been transcoded (i.e., had its format changed from one format to another, e.g., from FLV to MOV) loses many
of its high-frequency details and is more difficult to enhance. A video that has had its frame rate changed (e.g., a video that has
had its original frame rate of 7 frames per second changed to 15 frames per second by frame-rate doubling) is also difficult to
enhance since duplicate video frames can cause problems with frame analysis.

Forensic can still produce impressive results with videos that have been transcoded or have had their frame rates modified, but
enhancing a clean source will produce optimum results.
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MotionDSP Spotlight Custom Watermark
Last updated: 2021-03-02T18:39:03.000Z | Online Version

MotionDSP Spotlight Advance Timeline View
Last updated: 2021-08-09T12:39:45.000Z | Online Version

MotionDSP Spotlight Audio Segment Moving Ability
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MotionDSP Spotlight Automatic Face Suggestion
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MotionDSP Spotlight  Configurable Option for Auto Play   
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MotionDSP Spotlight Audio Redaction
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MotionDSP Spotlight Cycling through all layers
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MotionDSP Spotlight Hide Layer Geometry
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MotionDSP Spotlight Object Resize using Hotkeys
Last updated: 2021-08-09T12:31:01.000Z | Online Version

MotionDSP Spotlight Subtitle Feature
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MotionDSP Spotlight Subtitle Feature
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MotionDSP Spotlight User Interface Overview
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Forensic Studio and Spotlight 9.0 Overview
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Manual Tracking in Spotlight
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MotionDSP Spotlight 3 Spotlighting Methods
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MotionDSP Forensic, Spotlight, and Forensic Studio: Re    
hosting your License
Last updated: 2021-03-02T18:38:28.000Z | Online Version

MotionDSP Spotlight Concatenate
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Saving your project in MotionDSP Forensic and Spotlight
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Trimming Video Clips Spotlight
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Creating a Redaction Report in MotionDSP Spotlight

109

https://help.motiondsp.com/hc/en-us/articles/360048204371-Trimming-Video-Clips-Spotlight
https://help.motiondsp.com/hc/en-us/articles/360048204371-Trimming-Video-Clips-Spotlight
https://help.motiondsp.com/hc/en-us/articles/360048204371-Trimming-Video-Clips-Spotlight
https://help.motiondsp.com/hc/en-us/articles/360048204371-Trimming-Video-Clips-Spotlight
https://help.motiondsp.com/hc/en-us/articles/360048204371-Trimming-Video-Clips-Spotlight
https://help.motiondsp.com/hc/en-us/articles/360048204371-Trimming-Video-Clips-Spotlight
https://help.motiondsp.com/hc/en-us/articles/360048204371-Trimming-Video-Clips-Spotlight
https://help.motiondsp.com/hc/en-us/articles/360048204371-Trimming-Video-Clips-Spotlight
https://help.motiondsp.com/hc/en-us/articles/360047727772-MotionDSP-Spotlight-Snapshot-creation
https://help.motiondsp.com/hc/en-us/articles/360047727772-MotionDSP-Spotlight-Snapshot-creation
https://help.motiondsp.com/hc/en-us/articles/360047727772-MotionDSP-Spotlight-Snapshot-creation
https://help.motiondsp.com/hc/en-us/articles/360047727772-MotionDSP-Spotlight-Snapshot-creation
https://help.motiondsp.com/hc/en-us/articles/360047727772-MotionDSP-Spotlight-Snapshot-creation
https://help.motiondsp.com/hc/en-us/articles/360047727772-MotionDSP-Spotlight-Snapshot-creation
https://help.motiondsp.com/hc/en-us/articles/360047727772-MotionDSP-Spotlight-Snapshot-creation
https://help.motiondsp.com/hc/en-us/articles/360047727772-MotionDSP-Spotlight-Snapshot-creation


r 

 

Creating a Redaction Report in MotionDSP Spotlight
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Redacting Multiple Faces in Body Camera Video with      
MotionDSP Spotlight
Last updated: 2020-10-30T16:59:03.000Z | Online Version

Redacting Audio in MotionDSP Spotlight
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Redacting Audio in MotionDSP Spotlight
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Redacting Multiple Faces in Body Camera Video with      
Spotlight
Last updated: 2021-01-28T17:43:50.000Z | Online Version

 

Spotlight Video Redaction Software
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Spotlight Video Redaction Software
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How to Create a Redaction Report in Spotlight
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How to Redact Audio in Spotlight
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How to Trim Video Clips in Spotlight
Last updated: 2021-01-28T17:43:21.000Z | Online Version

 

How to Use the Audio Waveform Bar in MotionDSP       
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How to Use the Audio Waveform Bar in MotionDSP       
Spotlight
Last updated: 2021-01-28T17:44:11.000Z | Online Version

 

Workflow

Spotlighting
Last updated: 2021-01-28T17:25:41.000Z | Online Version

There are three ways to spotlight an individual or object in your video: 
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1. Use the ellipse or rectangle object and choose a Border area type 

2. Enable the background layer to darken, block, or blur the entire video. Then, use an ellipse or rectangle object and the No
Change or Border area type to make the area inside the ellipse or rectangle object visible.

3. Create an ellipse or rectangle object and select No Change. Under the Layer Options, select either Arrow or Text to
annotate the ellipse or rectangle object.

TIPS: When using an object with a No Change area type, the border displaying the boundaries of the object will not be visible
when saved or exported. To see your project as it will be exported select Lock Object Editing under Spotlight Tools. If you would
like a border, use the Border area type.
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Audio Redaction
Last updated: 2021-01-28T17:24:42.000Z | Online Version

Begin the audio redaction process by navigating to the section of the video where you would like the audio redaction to begin.
Click the keyframe button on the left side of Audio layer. 

Keyframe properties are displayed in the Tools Panel on the right side of the screen.

 

Mute is the default selection. Choose Resample effect type to alter the audio or Beep to insert a loud beeping sound over the
audio.

Play the video and add the second keyframe to mark the end of the Audio Redaction section.
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Play the video and listen carefully for audio that should be redacted. Add new keyframes before and after each time that audio is
present in the video.

NOTE: Audio redactions are not reversible. “Mute” completely removes the audio in the given section. “Beep”
completely overwrites the audio through the beep signal in the given section. “Resample” distorts frequencies of the
audio which changes the pitch randomly, not with a predefined value, so the audio cannot be reversed to its original
state.
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Video Redaction
Last updated: 2021-01-28T17:30:03.000Z | Online Version

In the Workspace Panel in the center of the screen, the video will be displayed. To begin the redaction process, select the
ellipse or rectangle masking element to mark the object to be redacted. 

Draw either an ellipse or a rectangle around the object to be redacted. Spotlight automatically creates the object layer and adds
a keyframe, displayed at the bottom of the screen.

Spotlight also creates a generic name for the object layer. It is good practice to rename the layer at this point and assign a more
intuitive name, like "Driver's face", instead of the generic name of "Ellipse.2".

NOTE: This layer name label is only to assist the editing process and will not appear in the final exported video
product.

Spotlight starts tracking the object automatically. The tracking is represented by a yellow dotted line appearing after the first
keyframe. The tracking is performed seven (7) seconds forward from the current seeker position.

Tracking "Ghost" is the distance from current seeker position. Play the video and notice that the tracking is chasing the Ghost.

If the tracker path requires adjustment, simply drag the ellipse or rectangle to correct the tracker path as necessary.
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Spotlight automatically adds a keyframe and completes the tracking. You will note that the question mark sign disappears from
the object name in the player as the tracking is now complete.

Repeat the redaction process for more objects, but note that Spotlight can track only three (3) objects simultaneously.  You can
redact more than three objects in your video but not all objects will be tracked at the same time.

In the example below, we are redacting the driver’s face, the driver’s license, and the passenger's face. All three objects will be
tracked simultaneously.

By using the Tools Panel on the right side of the application window, you can change the video masking element properties.
 Options include blur, block and solid color.  To prevent a redaction from being reversed, we recommend using the solid color
option to redact faces and objects.  The solid color option permanently changes the pixel values in the redacted area. For
example, the driver’s license is masked by the solid blue color set in the video masking element properties panel on the right
side of the screen.
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For objects that appear briefly in the scene, we recommend using the Keyframe Visibility feature. In our example, we drew the
rectangle around the driver’s license at the moment it entered the scene and added another keyframe at the point when it is no
longer visible. We then clicked the second keyframe and turned off visibility in Keyframe properties in the Tools Panel.
Keyframe Visibility can be turned on if the object reappears.

TIP: Do not create a new object layer for an object that reappears later in the video. Just create a new keyframe in the
original layer and visibility will be automatically turn on.

 

Features

Objects
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Objects
Last updated: 2021-01-28T17:25:19.000Z | Online Version

Video Masking Elements (Objects) include Ellipse and Rectangle. These can be used to blur, darken, or scramble individuals
or objects in the video. A label such as a caption or an arrow can be attached to the selected video masking element. The label
will move with the element.  

Toolbar
Last updated: 2021-01-28T17:40:36.000Z | Online Version

1. Select Tool  Tool for selecting and manipulating objects

2. Ellipse Tool  Create an elliptical object

3. Rectangle Tool  Create a rectangular object

4. Text Tool  Create a text annotation object

5. Video-Time Tool
 Create an annotation that displays the video's
timecode

6. Real-Time Tool 
 Create an annotation that displays the real video
time

7. Compare (Switch)  Enable/Disable layer visibility

8. Fit to Window  Zoom the video to fit inside the player

9. Rotate  Rotate the video 90 degrees clockwise

Layers
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Layers
Last updated: 2021-01-28T17:25:58.000Z | Online Version

The layer hierarchy panel shows all objects/annotations. Spotlight features four types of layers – object, annotation, background,
and audio: 

1. There is an object layer for each rectangle or ellipse object. 
2. Annotations are text or time overlays you can add to any segment of the video. 
3. The Background layer is present in every video. It includes everything that hasn’t been identified as an object to be

redacted.
4. The Audio layer is present if the video includes audio. An audio waveform is shown below the Audio layer to highlight the

sections of the video where audio is present.

Every layer has a specific color. Objects layers are blue, annotation layers are yellow, the background layer is brown, and the
audio layer color will depend on the redaction type.

There are several operations that can be performed with layers:

Add Keyframe to the Layer - select the 'diamond' icon on the left side of the layer, in order to add a new keyframe to the
layer
Drag & Drop Layer Reordering - hover the mouse over the layer name area and you will notice a hand tool. Drag the
layer and move it to another position.
Rename Layer - double-click on the layer name in the Layers panel or select the Edit button next to the layer name in the
tools properties panel in order to rename the layer.
Hide Layer - click the 'eye' icon on the right side of the layer in order to hide or show the layer. Hidden layers won't appear
either in the live preview or in the exported video product.
Delete Layer - click the 'trash' icon on the right side of the layer (next to Hide/Show layer button) in order to delete the
layer. The audio and background layer cannot be deleted but this action will delete all the keyframes from these layers.

TIPS: Spotlight will not display an audio layer if the workstation does not have an active sound output device

Automatic Face Suggestions
Last updated: 2021-01-28T17:26:36.000Z | Online Version

When a video is loaded into the Spotlight player in a paused state, Automatic Face Suggestions will run. Automatic Face
Suggestions will search the frame for faces and draw a bounding box around the face making it as easy as selecting the box to
begin the redaction and tracking process. 
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Automatic Face Suggestions - Select a bounding box to create redaction object

TIPS:

You can disable Automatic Face Suggestions from the Tools>Options processing menu

123



r 

 

Multi-Channel Audio
Last updated: 2021-01-28T17:38:35.000Z | Online Version

 

Multi-channel audio is common in a video with sound and each channel is displayed with its own layer in Spotlight. Video with
only one channel is called mono. Video with two channels is most often stereo audio, one channel for the left microphone and
one channel for the right microphone.  

The example track above is multi-channel audio but it is NOT stereo audio. The audio in this dashcam video comes from two
different sources. The first source, Audio 1, is the audio captured from the dashcam. Audio 0 is from the radio feed.

You can redact the audio from both tracks simultaneously or individually based on your configuration and requirements.

Spotlight User Interface Overview
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Spotlight User Interface Overview
Last updated: 2021-01-28T17:26:50.000Z | Online Version

There are three main panels in Spotlight.

1. The Project Panel on the left allows you to select the video to load into the Workspace player.
2. The Workspace Panel in the middle allows you to generate and move overlay elements and set keyframes. The

Workspace Panel contains: Mouse toolbar, Layer panel, and Player
3. The Tools Panel on the right allows you to change the properties of the overlay elements. 

The panel layout can be customized around using the View > Layout selection from the menu. This can be useful for making
more room for the Workspace and Tools panels when you are only working on a single video.

Spotlight Tools

Features
Last updated: 2021-04-20T03:01:23.000Z | Online Version
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1. Undo -Undo previous interaction

2. Redo -Redo previous undo

3. Lock Object Editing
-Lock changes to all layers (shows image as

it will be exported, no UI elements such as
layer names and object boundaries)

4. Delete Keyframe
-Delete the keyframe the playhead is on from

the selected layer

5. Delete All Layers -Delete all layers from the selected video

6. Previous Keyframe
-Go to the previous keyframe of the selected

layer

7. Next Keyframe -Go to the next keyframe of the selected layer

8. Toggle Lock Audio

-Disabled: Edit audio channels together
(Useful for normal Stereo and Mono Audio)

-Enabled: Edit audio channels individually
(Useful for audio with multiple sources
mapped to individual channels)

9. Rename
-Rename the selected layer (Currently

displayed as Ellipse.6)

10. Face Suggestion

-When you turn the face suggestion setting
on, human faces will be detected in a digital
image or video, allowing you to automatically
generate a redaction object based on that
detection

Object Properties
Last updated: 2021-01-28T17:37:56.000Z | Online Version
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Blur: 

Right: Low
Intensity,
Left: Hight
Intensity

Block:

Right:
Small Block
Size, Left:
Large
Block Size

No
Change:

Used in
conjunction
with other
objects to
"poke a
hole" in the
redaction
object or
background
layer
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Border:

Right: Low
Thickness,
Left: High
Thickness

Solid:

Tracking
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Tracking
Last updated: 2021-01-28T17:37:40.000Z | Online Version

Tracking is automatically started whenever a new ellipse or rectangle object is created.

1. Solid Line - Object motion path between keyframes is saved 
2. Dotted Line - Temporary tracking that requires a keyframe to save.
3. Tracking Progress Indicator - Tracking will only calculate 7 seconds ahead of the playhead per object as illustrated by the

Tracking Progress Indicator

Create keyframes by clicking the keyframe button on the left, next to the layer name
A keyframe is created whenever an object is manually adjusted
The object's motion path must be recalculated whenever a new keyframe is placed.
Tracking can be disabled for individual layers via the Spotlight Tools menu.
The maximum number of objects that can be tracked simultaneously is three

Visibility
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Visibility
Last updated: 2021-01-28T17:25:49.000Z | Online Version

For objects that appear briefly in the scene of a video, we recommend using the Keyframe Visibility feature. In our example, we
drew the rectangle around the driver’s license at the moment it entered the scene and added another keyframe at the point
when it is no longer visible. We then clicked the second keyframe and turned off visibility in Keyframe properties in the Tools
Panel. Keyframe Visibility can be turned on if the object reappears. 

TIP: Do not create a new object layer for an object that reappears later in the video. Just create a new keyframe in the
original layer and visibility will be automatically turn on.

 

Manual Track Data Correction
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Manual Track Data Correction
Last updated: 2021-01-28T17:39:02.000Z | Online Version

In certain scenes when automated tracking is not adequate or motion is unreasonable, Manual Track Data Correction can allow
you to make precise changes to the motion path of individual objects. To begin, Manual Track Data Correction must first have an
object that has been tracked between two keyframes. 

1. With the playhead between two keyframes and the desired object layer selected, navigate to Spotlight tools and select
Manual Track Data Correction

2. Step through the desired range frame-by-frame and adjust the object as necessary.
3. When finished, disable Manual Track Data Correction and review changes

TIPS:

Tracking status must be completed (solid line), Manual Track Data Correction cannot be completed on tracking that is in
progress (dotted line)

Arrow
Last updated: 2021-01-28T17:25:08.000Z | Online Version

A label such as a caption or an arrow can be attached to a selected video masking element.  An arrow can be used to
emphasize or highlight an object in the video. 

Text
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TextLast updated: 2021-01-28T17:26:17.000Z | Online VersionText annotation allows you to create labels in the video that are not associated with any video masking elements. TIPS:Text annotations, like other layers, can be controlled using keyframes and visibility  controls
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